O IDE baseado em
Eclipse

para desenvolvimento em Java

Joao Paulo Barros
Instituto Politécnico de Beja
Escola Superior de Tecnologia e Gestao
Beja, Portugal

Temos estado a utilizar um ambiente de desenvolvimento (em inglés, IDE para
Integrated Development Environment) que tem fins pedagogicos: o Blued. O BlueJ é um
excelente ambiente para o fim a que se destina: a aprendizagem da programacao
orientada pelos objectos utilizando a linguagem Java. No entanto e especialmente
quando é utilizada uma linguagem muito popular como a linguagem Java, o
desenvolvimento de programas € feito utilizando IDEs muito mais complexos e
sofisticados. Tal é necessario para lidar com a complexidade de muitos dos programas
actuais. Estes atingem frequentemente dezenas de milhares de linhas de cédigo e,
nalguns casos, muitas, muitas mais. Tal implica a utilizacao de varias ferramentas de
auxilio ao desenvolvimento de cédigo. Estas ndo se resumem ao editor de texto e ao
compilador, incluem também coisas como ferramentas de suporte a geracdo de testes
(unit testing frameworks) depuradores (debuggers), controlo de versoes, editores para

construcao de interfaces graficas e editores para linguagens graficas (e.g. UML).

Todas estas ferramentas sao importantes pelo que os IDEs modernos tém vindo a
incluir todas elas. Ou seja, integram cada vez mais ferramentas. O eclipse € uma
resposta a esta necessidade de integrar ferramentas distintas para o desenvolvimento

de software. Em http://wiki.eclipse.org/index.php/FAQ What is Eclipse%3F

encontramos esta definicao:

Eclipse is an open (IDE) platform for anything, and for nothing in particular. Eclipse is open
because its design allows for easy extension by third parties. It is an Integrated Development
Environment (IDE) because it provides tooling to manage workspaces; to build, launch and debug
applications; to share artifacts with a team and to version code; and to easily customize the
programming experience. Eclipse is a platform because it is not a finished application per se but is
designed to be extended indefinitely with more and more sophisticated tooling. Eclipse is suitable
for anything because it has been used successfully to build environments for wide-ranging topics,

such as Java development, Web Services, embedded device programming, and game-programming


http://www.bluej.org/
http://wiki.eclipse.org/index.php/FAQ_What_is_Eclipse%3F
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contests. Eclipse has no particular focus on any vertical domain. The dominance of Java
development tooling in Eclipse is merely historical. The platform has no explicit or implicit support
whatsoever for Java development as provided by the Java development tools (JDT). The JDT has
to play according to the same rules as all the other plug-ins that use the platform.
Pois é. O Eclipse da para muita coisa. Apesar de todas estas ferramentas terem a sua
utilidade, por agora vamos centrar-nos na utilizacdo mais popular do eclipse: o seu
IDE para Java. Para muito mais informacao do que aquela que aqui sera dada,

aconselham-se as referéncias na Leitura Complementar no final deste texto.

Vamos entdo seguir o caminho necessario até por o eclipse a funcionar. Para tal,

vamos considerar quatro passos: obtencao, instalacao, execucao e configuracao.

No cédigo seguinte utiliza-se esta fonte para texto que surge na interface do eclipse.

1 Obtengado

O Eclipse é disponibilizado a custo zero na Internet. Pode fazer o download do Eclipse SDK que inclui o IDE

Java em http:/ /www.eclipse.org/downloads/:

@& Eclipse downloads home - Mozilla Firefox BEX
Fle Edit View Go Eookmarks Tools Help &3

Qa & E} < l@ \:I @[ B htto: s eclipse. orgjdownioads/ [:} © o B,

e Official Eclipse FAQs - Eclipsepedia - | & eclipse downloads home

Edipse‘orgnavigaﬁon‘ Home‘ Commumy‘ Membership

Committers

i E In: 0]
Newsgroups Eclipse downloads home Ehpas iata ol
Do you find the top-10
Bugs Get Eclipse. list {below) useful?
Articles ; : Ovesluseitasa
If you're new to Eclipse, start by downloading the Eclipse SDK, then browse the various hortout -

project pages to find the useful tools and plugins that you need. You will need a Java

Downloads Home O ves, 1 giscoversd new

runtime environment (JRE} to use Eclipse. All downloads are provided under the projects
By project terms and conditions of the Eclipse.org Software User Agreement unless otherwise o
e *es, for no ressen
By topic Ow:meany
e ] | Download now: Eclipse SDK 3.1.2, Windows (103 M8) fﬁ;d““w Bt R
Le /;D _l [torrents] Vote
= Other downloads for 3.1.2. | All versions | Newsgroups |
Documentation and help Top-10 Downloads
1. Web Tools
2. Eclipse
Browse downloads e it
3. CiC+s
+ By Project ¥ 3::‘:“:?;1:"' [l
Done S/

Clicando em Eclipse SDK 3.1.2 ira para a seguinte janela:
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@ Eclipse downloads - mirror selection - Mozilla Firefox ‘
Fle Edt Vew Go Bookmarks Tools Help

-t - B () @) [ hesfu.ecipse.orgjdowrlosds donrioad.sho?fle—/edipss dourloacs rops -3 122 v | @ 6o | B,

- | & eclipse downloads - mirror selection |

| B The Offical Ecipse FAQs - Edipsepedia

Contact | Legal

- .
eclipse

Edjpse.orgnavigaﬁunl Homel Commumtyl Membership

Committers
Newsaroups Eclipse downloads - mirror selection ey

Bugs Please select a mirror for eclipse-SDK-3.1.2-win32.zip (xml)

+ FTP mirrors only

+ HTTP mirrors only

S " (zmi;
sl All downloads are provided under the terms and conditions of the Eclipse.org Software & :‘mmwsumw
User Agreement unless otherwise specified.

Downleads Home

By project g 1—4[ Download from: [Portugal] Departamento de Ciéncia de Related Links
(04
By topic 9 S| Computadores, FCUP {hitp)  Becaiing s fier
5 ...or pick a mirror site below. aite
Source code - + Keeping up to date
Using the Update
Mansger
Please choose a mirror close to you + Eclipse
newsgroups
Europe
» [Portugal] Instituto Superior Tecnico - Rede das Novas Licen (ftp)
s+ [Portugal] INESC Porto (ftp)
> [Bulgaria] Prolet Software (http) lV|
Done S

Clicando no link sugerido ou num dos mirrors devera fazer save para o disco do seu computador:

Opening eclipse-SDK-3.1.2-win32.zip

‘You have chosen to open
[#] edlipse-SDK-3.1.2-win32.zip

which is a: Compressed (zipped) Folder
from: http:/fedipse.dcc. fo.up.pt

What should Firefox do with this file?

() Open with | CompressedFolder (default) M

[] Do this automatically for files like this from now on.

O download devera demorar varios minutos. Na mesma pagina encontra muito outros links que lhe
possibilitam varias formas distintas de fazer o download. Se a ligacao que esta a utilizar for lenta ou pouco

fiavel pode ser boa ideia utilizar um software para gerir downloads (o http://www.freedownloadmanager.org/ é

um dos melhores).

2 Instalagdo

Antes de instalar o eclipse deve instalar o Java SDK 1.5. Em principio ja o deve ter
instalado, pois ele também ¢é utilizado pelo Blued que temos estado a utilizar. Vamos
assumir que o SDK esta instalado na directoria C:\Program Files\Java\jdk1.5.0_06 e

vamos descrever a instalacdo no sistema operativo Microsoft Windows XP.

A primeira tarefa é a de descompactar o ficheiro eclipse-SDK-3.1.2-win32.zip para

uma directoria. Vamos assumir a directoria C:\eclipse. Na descompactacao basta
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abrir o ficheiro zip, que contem uma directoria eclipse, e copia-la para a directoria

C:\. Tal deve demorar alguns minutos pois sdo muitos ficheiros. Note que desde que

tenha permissoes de escrita na directoria escolhida para destino, neste caso a

directoria C:\, ndo necessita de privilégios de administrador para fazer esta operacaol.

Logo que a descompactacéao tiver terminado, deve ter uma directoria C:\eclipse com o

seguinte conteudo:

J Ceclipse [Z] @
File Edit view Favorites Tools ar
- s ) -
@ Back d ? 7 Search Folders 3 x g
Address |3 C\edipse 'Vi Go | Norton AntivVirus ) ~
Attribu... | Mame Size | Type Date Modified
[’ File Folder 17-04-2006 23:33
=) features File Folder 17-04-2006 23:33
C)plugins File Folder 17-04-2006 23:33
[Cireadme File Folder 17-04-2006 23:33
.edipseproduct 1KB ECLIPSEPRODUCT File  18-01-2006 16:28
A = edipse.exe 108 KB  Application 18-01-2006 16:28
A B edipse.ini 1KE Configuration Settings 18-01-2006 16:28
Bl epl-y 10.html 17KB  HTML File 18-01-2006 16:28
i_g-__]notice.hh'nl TKE HTML File 15-01-2006 15:23
A :l= startup.jar 32KB MNokia Application In...  18-01-2006 156:28
10 objects 162 KB 4 My Computer

Agora € aconselhavel fazer mais uma configuracdo: adicionar um shortcut para o

ficheiro eclipse.exe. Tal pode ser feito em trés passos: (1) seleccionando o ficheiro, (2)

fazendo Edit->Copy, (3) Edit->Paste Shortcut.

Seguidamente, deve clicar com o botdo do lado direito do rato no shortcut criado e

colocar o seguinte texto em Target (vide imagem seguinte):

C:\eclipse\eclipse.exe -vm "C:\Program Files\Java\jdk1l.5.0_06\bin\javaw" -vmargs -

Xmx256M

1 E boa ideia trabalhar sempre como utilizador restrito (restricted user) no Windows XP e s6 utilizar a conta

de utilizador quando é mesmo necessario.
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Shortcut to eclipse.exe Properties

Genemll Shortcut |C ibility | Security

I? Shortcut to eclipse.exe

Target type: Application

Target location: eclipse|

Target: C:Mprogramas*eclipseeclipse exe -vm "C:\Progra

Start in: Ceclipse

Shortcut key: |N0r|e ‘

Run | Mormal window [v]

Comment

[ Find Target ] [ Change lcon ] [ Advanced ]

oK [ cancel | [ eey |

Esta linha especifica explicitamente qual a maquina virtual Java que sera utilizada
para executar o eclipse e qual a quantidade de memoria que deve ser especificada. Isto

€ aconselhado no ficheiro C:\eclipse\readme\readme_eclipse.html.

Finalmente, o shortcut pode ser copiado para o desktop ou para outros locais da sua

preferéncia.

Agora ja pode executar o eclipse.

3 Execugdo

Fazendo duplo click no shortcut criado devera obter a seguinte caixa de dialogo:

Workspace Launcher

Select a workspace

Edlipse SDK stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | C:\Documents and Settings'jpb'workspace ﬂ Browse...

I™ Use this as the default and do not ask again

oK | Cancel
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E boa ideia evitar a localizacdo por omissao (default). Em vez disso crie uma nova
directoria e passe a utiliza-la por omissao. Por exemplo, considerando a directoria

C:\eclipseProjects teremos:

Workspace Launcher ﬂ

Select a workspace

Edlipse 5DK stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session,

Waorkspace: I Ct\edipseProjects LI Browse... |

[V Use this as the default and do not ask again

Cancel

Clicando em OK devera obter uma janela introdutéria.

SOK
Ge Fl lavge Segch Boecl B Wrow teb §
& weicome 7 1A =10

Welcome to Eclipse 3.1

Mais tarde pode seguir as tutorias (segundo icon a contar da esquerda) mas por agora
vamos apenas fechar esta janela Welcome. Para tal, deve clicar no simbolo x no
campo superior esquerdo, logo apos a palavra Welcome, ou seja, fechar a tab
Welcome. Chegamos assim a resource workbench do Eclipse, ou seja, a bancada de
trabalho de recursos. Este nome soa algo estranho pelo que vamos utilizar o nome em

inglés: resource workbench.
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[Eie gt Sorce Refacir Wwgesr Seach Propet fm findow Hep
Iles - #-0 Q- HEHG |
13 Pacage Exglorer £ merwrchy| — O
uma
view
B Probdeme T Jmuackor | Declaration
) ervars, O warrirags, 0 knfon .
| Desription

Permite mudar
a perpectiva
em utilizacao.

[ Resnrce

zona para editor

[ I Fokier [ Locatin

A perpectiva
em utilizacao
é a “Java”.

outra
view

outra view

O conceito de perspective ¢ muito importante no Eclipse. Uma perspective define

quais e como surgem no bancada (na workbench) as views que lhe estdo associadas. A

razao para este funcionamento resulta do facto de ser conveniente uma arrumacao

diferente (uma diferente perspectiva) para cada tipo de tarefa que possamos estar a

realizar. E note-se que o Eclipse suporta muitos tipos de tarefas. A perspectiva

apresentada esta feita para programacao em Java e denomina-se simplesmente Java.

Note-se que as perspectivas estao disponiveis no menu Window->Open Perspective,

conforme ilustrado na figura seguinte:

2 Java - Eclipse SDK

Fle Edit Mavigate Search Project Run | Window Help

Customize Perspective...
Save Perspective As...
Reset Perspective

Close Perspective

Close All Perspectives

Mavigation »

Preferences...

0 errors, 0 warnings, 0 infos
Description

L=<; - :)‘G" - D i Qo - |+ MewwWindow l
u| 11 .
té Package Explorer E@ Hierard’w‘ = e
- | QpenPerspective * %5 Debug
E E.| show View »
= ow View | 31. 1

5‘1 Java Browsing

Other...

Javadoc | Dedaration |

] Resource ] In Folder

=1 aJJa\ra 2%
= O[5 outine’ £2 S
| |An outline is not available.
==
E At

[ Location
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Vamos agora criar um projecto que ira suportar o nosso programa. Primeiro vamos
espreitar trés botdes que estdo na toolbar. A figura seguinte mostra um desses botoes

ja seleccionado: o New Java Project. Os outros dois sdo os que estao a direita: New

Java Package ¢ New Java Class.

2 Java - Eclipse SDK (99][=1 % )

File Edit Mavigate Search Project Run Window Help

[ w1 [#%-0-@- |- & " TR 5| &'3ave =
[% Package Explarer 52 .\_r:h'erardw| = Néw Java Project = ] E‘Em&!e X =)
£ ‘ = <§> = An outline is not available,

& ¥ =0

& Problems 5 Javadnc‘Dedarahnn| R
e

0 errors, 0 warnings, 0 infos
I Description | Resource | In Folder

&l fm [

Vamos entdo criar um novo Java Project para o nosso programa de exemplo, o

Figures. Temos entédo o seguinte didlogo que pode ser visto como um wizard:

< New Java Project m

Create a Java project J
e
Create & Java project in the workspace or in an external location. Z 7

Project name: I Figures

[ Contents

% Create new project in workspace

" Create project from existing source

Direckary; |C: edipseP! Browse,. ., |
r— JDK Compliance
~ Use default compiler compliance (Currently 1.4) Confiqure default...

{* Use a project spedific compliance: (5.0 =

Project layout

"~ Use project folder as root for sources and dass files

{¢ Create separate source and output folders: Configure default...

= Back Mext = | Einish I Cancel
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Aqui ha varias coisas a fazer:

1. Dar um nome ao projecto (no nosso exemplo € Figures);

2. Especificar o JDK Compliance para a versdo 5.0 do Java e Configure Default.

Esta opcao apresenta o seguinte dialogo.

'S Preferences (Filtered)

[fme 5 B || Compler

= Java
% Compier
Installed REs

| IDK Campliance —
Compiler compliance level:

¥ Use default compliance settings

] i

[~ Classfile Generation

[¥ Add variable attributes to generated dass files (used by the debugger)

[¥ Add ine number attributes to generated diass fles (Used by the debugger)
¥ Add source file name to generated dass file (used by the debugger)

¥ Preserve unused (never read) local variables

I™ Inline finally blocks (iarger dass files, butimproved performance)

Restore Defaults Apply

Ai deve escolher 5.0, tal como indicado na figura, e fazer OK. Tal origina a seguinte

pergunta:

= Compiler Settings Changed

s/ take effect. Do the full build now?

# | The compller settings have changed. A full rebuild is required for changes to

Responda Yes. Parece coisa complicada mas € muito rapido.

Estas opcoes ficam disponiveis para futuras consultas ou alteracoes em_Project-

>Properties.

3. No Project layout deve especificar diferentes directorias para source e output

files. Tal originara diferentes directorias para os ficheiros .java e .class. E uma

questao de arrumacao. Estabeleca também tal como default. Na janela seguinte

escolha Folders.
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= Preferences (Filtered) - okd
fitered ~| Ek | Build Path =
= Java
1 BT Specfy the buld path eniries used s default by the New Java Project reation

-~ Source and output folder
1 Project
{ Folders

Source folder name: [src

Qutput folder name: [ bin

#s JRE lbrary use: [JRE container =

Restore Defaults Apply

Voltando a janela New Java Project, podemos agora clicar em Next. Na janela
seguinte basta clicar em Finish. Note que nesta janela também pode clicar em Back

para voltar atras. E a este tipo de “janelas em cascata” que é costume chamar um
wizard.

= New Java Project m

Java Settings .l
Define the Java build settings. i

1= Projects | B Lbraries | {5 Order and E:cportl

e FENE)]
= b‘J Figures
- src

+ Details
@9 Add project Figures' to build path: Add the project to the build path if

the project is the root of packages and source files, Entries on the build
path are visible to the compiler and used for building.

[~ Allow output folders for sourge folders

Default output folder:

| Figures bin Browse...

< Back [exk = | Einish I Cancel
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Agora, o projecto criado devera aparecer na view da esquerda, na tab Package

Explorer:
< Java - Eclipse SDK =JoJEd
File Edit Source Refactor MNavigate Search Project Run  Window Help
i #H-0-Q- | EHFG- | @Y g g i | &' 1ava =
[# Package Explorer 52 Hierarchy | — O = | EE Outline EX. 3 =i
e An outline is not available.
= =
+1-1 figures}
|_':_ Problems &2 Javadoc | Dedaration ::'., et
0 errors, 0 warnings, 0infos ) )
| Description | Resource | In Folder
(%] >
Figures

Podemos agora comecar a criar o programa propriamente dito! Para tal vamos comecar

por criar uma package.

E boa ideia colocar as hossas classes em packages (pacotes) tal como sucede com as classes da biblioteca do Java.
Por exemplo, o verdadeiro nome da classe ArrayList € java.util.ArrayList. Para utilizarmos o home curto

(ArrayList) temos de colocar uma instrugdo import java.util. ArrayList no ficheiro onde a pretendemos utilizar.

As packages permitem evitar colisGes de nomes. Por exemplo, é possivel que fagamos uma classe chamada Worker
que queremos adicionar a um programa de gestdo de saldrios. Acontece que jd ld pode existir uma classe com esse
nome. Se colocarmos a nossa dentro de uma package denominada salary entéo o nome completo da nossa classe
passa a ser salary.Worker. Isso é feito adicionado a seguinte directiva como a primeira instrugdo no ficheiro

Worker.java:
package salary;
import java.util.ArrayList;

public class Worker

¥

Claro que podemos ter mais azar ainda e jd existir uma package com uma classe Worker! Como podemos entdo
garantir que os nomes das classes nunca colidem com outras que jd existam? A Sun recomenda que utilizemos a
seguinte convengdo para os nomes das packages: colocamos o inverso do nosso nome de domihio na Net. Por
exemplo:

pt.ipbeja.estig.p2.salary.Worker
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Desta forma garantimos que a classe Worker definida na disciplina de programagdo 2 da ESTIG tem um nome
diferente de outras também denominadas Worker. Note que se utilizam letras mintsculas para os nomes das

packages, mas os nomes das classes, como sempre, surgem em letra maitscula.

A organizagdo das classes em packages é muito semelhante a organizagdo dos ficheiros em directorias. Na
verdade tal é aproveitado para guardar os ficheiros. Na verdade temos de colocar o ficheiro Worker.java ha

directoria pt\ipbeja\estig\p2\salary. Felizmente, hd vdrias ferramentas que tratam disso automaticamente e o

Eclipse é uma delas.

Vamos entao criar uma package com o nome pt. ipbeja.estig.p2.figures. Para tal

deve premir o botao New Java Package mesmo ao lado do botao New Java Project.

Deve entao indicar o nome da package no didlogo seguinte:

= New Java Package
Java Package

Create a Java package. £
Creates folders corresponding to packages.

Source folder: |Figures,"src Browse...
Name: | pt.ipbeja.estig.p2.figures

Criemos agora uma nova classe denominada Figure. Para tal seleccionamos a package

criada no Package Explorer conforme ilustrado na figura seguinte:

= Java - Eclipse SDK =]
File Edit Source Refactor Mawigate Search Project Run  Window Help
=k -0 Q- |[LEE- @y - B e E
% Package Explorer &3 Herarchy| ~ O = 0 [5E outine T
RN n outine is not avaiable.
= 123 Figures
= arc

8 ptipbeja.estig,p2. figures!
B JRE System Library [idk1.5.0_08]

[2 Problems £2 _Javadoc | Dedaration | o m|
0 errors, 0 warnings, 0 infos
| Descrigtion | Resource In Folder

&l ‘ (2]

pt.ipbeja. estig.p2. figures - Figures/src
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Depois, utilizamos o botdo New Java Class. Repare que clicando imediatamente a

direita desse botao tem opcodes para criar um JUnit Test Case, Class, Interface,

Enum ou Annotation. Por agora vamos ver apenas a opc¢do Class que faz surgir o

seguinte dialogo:

= New Java Class m
Java Class
Create a new Java dass. @
Source folder: | Figures/src Browse...

Package: I pt.ipbeja.estig.p2. figures Browse...

7
I~ Endosing type: | Browse. . . |

MName: IFigure
Modifiers: & public  default € private € protected
IV abstract [ final ™ static
Superclass: I java.lang.Object Browse
Interfaces:

Which method stubs would you like to create?
I~ public static void main(String[] args)
I~ Constructors from superclass
¥ Inherited abstract methods

Do you want to add comments as configured in the properties of the current project?
i | Geperate comments

Finish Cancel |

Aqui basta preencher o nome da classe (neste caso Figure) e dizer que se trata de uma

classe abstracta. Neste momento ja tera uma workbench um pouco mais interessante:

= Java —ﬁgure.java - Eclipse SDK LEJLQJN
File Edit Source Refactor MNavigate Search Project Run Window Help
Ii-Ha%s-0-%- | EHG- ™5 |[4B |8 -4 -m0- - & | &1 =
[# Package Explorer SE“’K\Hierard'ly S 4] Figure.java S@k\_‘ S IEE Outline &% \\_, -8
Y | =] <‘::='=> = || | package pt.ipbeja.estig.p2.figures; 18 & w e Y
[=l-1=> Figures - H  ptipbeja.estig.p2.figures
- # src ~“public abstract class Figure { 5__@#\ Figure
8 pt.ipbeja.estia.p2.figures
H - [J] Figure.java }
i+l B JRE System Library [idk1.5.0_08]
[ Problems 52 ‘._Ja\radoc|DadaraDon| Xm0
0 errors, 0 warnings, 0 infos
Description | Resource | In Folder | Location |
| | Writable SmartInsert | 6:1 |
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Agora vamos fazer copy/paste do restante cédigo da classe Figure cuja resolucao foi ja

dada. Ficara assim com uma classe completa.

Agora vamos experimentar outra forma de incluir uma classe ja feita. Tal é muito ttil
para aproveitar codigo ja feito: clique com o botao direito em cima da package

pt.ipbeja.estig.p2.figures e seleccione a opcdo Import. Obtera o seguinte dialogo:

= Import
Select \
Import resources from the local file system into an existing project. E - E

Select an import source:

@; Archive file

%‘:" Checkout Projects from CVS
ﬁExisting Projects into Workspace
L External Features

’-E;E;(ternal Plug-ins and Fragments
[ File system

Elpreferences

('E],Team Project Set

Cancel

I Next > l

Clique Next e na janela seguinte escolha a directoria onde tem o projecto Figures:

= Import
File system =
Import resources from the local file system. E?

-

From directory: |C:\,UUD\,ESTIG\2EIUE-ZUUG\ Verau\_PlVerao_ZUUE_ZUUG\F\gL_:j Browse... I

~[E] = Figures

[ = bluej.pkh
[ fuCircle. dlass
0O i circe.ctxt L
[ cirde java
[m} Jmi};Figl.ma.t:hass
[ El Figure. ctxt
[ [31 Figure.java
[m} @Pu\ygun.dass

|
M = paluann. it -]
Filter Types... | Select All Deselect All |
Into folder: I Figures/srcfptfipbeja/estia/p2/figures Browse... I
[~ Options

B QOverwrite existing resources without warning
" Create complete folder structure

+ Create selected folders only

< Back Mt = I Finish I Cancel
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Por agora, seleccione apenas o ficheiro Circle.java, tal como ilustrado na figura

anterior, e clique Finish.

Este ficheiro tera um erro porque néo tem a indicacdes que esta na package

pt.ipbeja.pestig.p2.figures. Corrija esse facto acrescentando a linha

package pt.ipbeja.estig.p2.figures;

no inicio do ficheiro.

Por fim, vamos adicionar uma classe com um main ao nosso programa. Todas as
classes podem conter um main mas nés vamos criar uma que sé contem esse método.

Agora vamos também pedir para gerar comentarios:

2 New Java Class

Java Class

Create a new Java dass.

Source folder: ] Figures/src Browse...

Package: ] pt.ipbeja.estig.p2. figures Browse...

e}

[ Endosing type: ]

Name: ismrt
Modifiers: & public " default (e C
[~ abstract [ final [~ static
Superdass: ]java.lang.Dbject Browse... |
Interfaces: A

Which method stubs would you like to create?
¥ public static void main{string[] args)
[~ Constructors from superdass
¥ Inherited abstract methods
Do you want to add comments as configured in the properties of the current project?
¥ Generate comments

Finish | Cancel

Agora ja temos trés classes no nosso projecto:
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S Java - Start.java - Eclipse SDK. =X
File Edit Source Refactor Navigate Search Project Run  Window Help

G- LG5 -0 [BEG-|®F | 42 |5 5 -wa-o- 5 @ >
I‘I:g Package Explorer 57 “Hierarchy| = 3|( [] Figure java | [3] cirde.java ‘ [ start.java 52 \_‘_ = O || 2= outiine &2 \.\__ = [

@/ %=
package pt.ipbeja.estig.p2.figures;

2B~ BB e T
- ptipbeja.estig.p2.figures
=@, start

- @ ¥ main(String[])

':J'LsJ Figures
(- src
=3 ptipbeja.estig.p2.figures

*
i “public elass Start {

IRE System Library [idk1.5.0_08]

| = JEw

* Eparam args

=/

[£{ Problems 5 Ja\radoc| Dedarab'on| ®x LY =0
0 errors, 0 warnings, 0 infos
I Description

| Resource | 1In Folder | Location |

| ‘ pt.ipbeja.estig.p2. figures.Start.java - Figures/src |

Note que o codigo fonte das classes criadas (os ficheiros .java) estdo dentro das
directorias correspondentes a package criada. Como a package criada foi
pt.ipbeja.estig.p2.figures, os ficheiros estao dentro da directoria
pt\ipbeja\estig\p2\figures. Esta, por sua vez, esta dentro da directoria src, e a
directoria src esta dentro da directoria correspondente ao projecto (Figures).
Finalmente, este projecto esta dentro da directoria que definimos, no inicio, como o

workspace do eclipse:

X

J C:\eclipseProjects\Figures\src\pt\ipbejaestig\p2\figures
File

Edit

e Back - .\_‘:]

Address |E,'] C:\edipseProjects\Figures\src\ptlipbeja‘estio\p 2\figures

View Favorites Tools Help

lﬁ pSEErm H_" Folders |._-5‘ (3 x q -.-
OCE

(=X
L

MNorton AntiVirus @ -

Attribu... | Mame =~ Size | Type Date Modified

A E] ; 1KE JAVAFFile 15-04-2006 10:38

A E:I Figure.java 1KB JAVAFile 13-04-2006 10:38

A E] Start.java 1KB JAVAFile 18-04-2006 10:52
3 ohjects 2,18 KB ¢ My Computer
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Vejamos agora o método main que foi criado: a frase // TODO Auto-generated method

stub dentro do método main significa que esse € um sitio para fazer coisas (to do).

Vamos entdo fazer algo minimo sé para ver o programa a funcionar:

public static void main(String[] args)
Circle c = new Circle(2, 2, 3.0);
System.out.printin(c.area());

}

Vamos entéo seleccionar o ficheiro Start. java no Package Explorer e clicar no botéao
Run. No dialogo que surge, escolhemos Java Application na lista de tipos de
Configurations possiveis (rectangulo a esquerda) e escolher criar uma nova aplicacao
Java (botao New):

< Run
Create, manage, and run configurations
Run & Java application @
Configurations: Name: | Btart
4@ Edipse Application
B4 Java Applet - -
-] Java Application © Main I[K.'F Argumentsl =i JRE! %, Clazepath I By Scurcel 4] Enwonment! 1 I s
b Start —Project:
Ju Junit 3
+ Fi Browse...
34 JUnit Plug-in Test | Figures —l

@ SWT Application
—Main dass

| pt.ipbeja.estig.p2. figures.Start Search... |

[ Indude libraries when searching for a main dass

[~ Indude inherited mains when searching for a main dass

' Stop in main

New Delete aopli | Revert |

Podemos entdo clicar em Run. O resultado deve aparece na tab Console na view

inferior da workbench:
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s o
= Java - Start.java - Eclipse SDK ML@JN
File Edit Source Refactor Navigate Search Project Run  Window Help
|-l |%-0-%- |BEF- @ |[4B |- -6 - £ | §lmva i
[% package Explorer 528 .\_}:ﬁerard’1y| = O || [4] Figurejava | [J] circle.java (m Start.java 23--\_‘ = | B= outiine &2 \.\__ =
2| Bs T “public class Start { b]_ G
':JLDJ Figures s # ptipbeja.estig.p2.figures

= S a-

o Start
- @ % main(String[l)

*y
- = public statie wvoid main(String[] args) {
| Circle ¢ = new Circle(2, 2, 3.0);

: - & Cirdefint, int, double) _
i @. areal) - System.out.printlin(c.area(}):
e equals{Object) -
: & getRadius() - 1
£ o @ perimeter() o
+-[J] Figure.java U
[ start.java =
B, JRE System Library [jdk1.5.0_0&] thlems|Javadoc|Dedaraﬁon | El console 2 i % ‘ Expl|l#B-r5-=0
<terminated > Start [Java Application] C:\Program Files\Javaljdk1. 5.0_06\bin\javaw.exe (18/Abr/2006 10:54:41)
28.274333882308138

E | | writoble | smartInsert | 19:1 |

Nas proximas vezes que queiramos executar o programa, basta clicar no botdo Run e
ele ira executar a configuracédo de execucao que esta seleccionada: no nosso caso €

Run Start.

Finalmente, vamos configurar algumas coisas

4 Configuragdo

Clique com o botao direito no fundo da janela editor e escolha Preferences (altima
opcao no menu de contexto). No rectangulo a esquerda, escolha Java->Editor.

Seguidamente escolha compiler warnings e, no rectangulo da direita. Escolha

Warning em todas as linhas dentro de Potential Programming problems, Name

shadowing and coflicts, e Unnecessary code.
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'S Preferences (Fi ltered)

BT

| filtered = B

Errors/Warnings

& -

[+ General
[=- Java
[=|- Editor
i Code Assist
Folding
Howers
Linked Mode
Mark Ocourrences
i Syntax Coloring
i Templates
- Typing

|<| i1l ”}|

Configure Project Spedific Settings...

+ Potential programming problems

Seriglizable dass without serialVersionlID:

Assignment has no effect (e.g. % = x):

Possible accidental boolean assignment (e.g. if (@ =b)):
‘finally' does not complete normally:

Empty statement:

Iising a char array in string concatenation:

Hidden catch blodk:

+ Name shadowing and conflicts

Field dedaration hides another field or variable:

Local variable dedlaration hides another field or variable:
[ Indude constructor or setter method parameters

Type parameter hides another type:

Methods overridden but not package visible:

Interface method conflicts with protected 'Object’ method:

¢ Deprecated and restricted APT

+ Unnecessary code

Local variable is never read:
Parameter is never read:
[ check overriding and implementing methods

Unused imports:

Unused local or private members:

Restore Defaults | Apply I

i
Warning -
Warning -
Warning -
Warning -
Warning -
Warning -

Warning -

Warning -

Warning -

Warning -
Warning -

Warning -

Warning -

[warning <]
[Warning <
[warning <]
[warning <]
[warning <]
[warning <
[warning <]
[warning <
[Warning =
[warning <
[warning <
cnog =]

Warning -

Warning -

i

oK I Cancel |

Clique OK e escolha Yes no dialogo seguinte:
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P

= Error/Warning Settings Changed ﬁ

The Error /Warning settings have changed. A full rebuild is required for
= changes to take effect. Do the full build now?

Yes Mo

Novamente, clique com o botéo direito no fundo da janela editor e escolha Preferences
(Gltima opcao no menu de contexto). No rectangulo a esquerda, escolha General-

>Editors->Text Editors e coloque 3 em Displayed tab width. Escolha também a

opcao Show print margin e Show line numbers:

3 Preferences (Filtered) BE <
[fitered | G| TextEditors Sl
=+ General

= Editors Displayed tab width:

I 4
|=- Text Editors
. Accessibility Undo history size; I 25
- Annotations Iv Highlight current line
- Quick Diff
: - Speling
- Java Print margin column: I a0

Iv Show print margin

v Show range indicator
v Support hyperlink style navigation

Hyperlink style navigation key modifier: I Ctrl
[ Disable overwrite typing mode

Appearance color options:

ILine number foreground Color: [N
Current line highlight - —I

Print margin

Selection foreground color
Selection background color
Background color
Foreground color
Hyperlink

Mare colors can be configured on the Colors and Fonts preference page.

Restore Defaults | Apply |

QK I Cancel |
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Voltando ao editor, repare que surgem os numeros de linha e uma linha vertical na

coluna 80.

Note e experimente ainda as seguintes funcionalidades:

e Se premir F4 quando o cursor esta num identificador de classe, sera aberta (ou
actualizada) a Hierarchy view. Experimente, por exemplo, com o identificador

Circle no método main.

e Se premir F3 quando o cursor esta num identificador de classe, ira para a
definicao dessa classe. Experimente, por exemplo, com o identificador Circle

no método main.
e Se premir os sinais — ou + que surgem junto aos nimeros de linha, os blocos
(ou grupos) respectivos ficam invisiveis ou visiveis, respectivamente.

Experimente com o que esta ao lado do cabecalho do main e com outros.

e Quando escreve o nome de um objecto e depois o ponto, note que surge a lista

de métodos que compdem a interface desse objecto.

e Experimente as tabs Problems, JavaDoc e Declaration na view na parte

inferior da workbench. Com a Declaration seleccionada, experimente clicar no

identificador Circle no editor.

e Para activar os asserts:

0 Para testar, adicione, por exemplo, assert(false) no método main.

0 Verifique se esta seleccionada a configuracdo Java Application->Start.

0 Escolha a opcdao Run no menu Run (Run->Run).

0 Seleccione a tab Arguments.

0 No campo de texto VM arguments (argumentos para a maquina virtual

Java) adicione o texto “—ea”.
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(Shun =]

Create, manage, and run configurations

Run & Java application @

Configurations: Name: | Start

& Edipse Application

-] Java Applet = -
£1- 03] Java Application © vain 09 Arguments | = e | % Casspath | 1 Source | P8 Environment | <[>
3] start i~ Program arguments:

~Jr JUnit

Jo JUnitPlugn Test

-[5] sWT Application

Varizbles. ..
VM arguments:
<a

Variables. ..

igures}

W Use defauit working directory ‘wWarkspace. .. | File System... | Vatiables... I

New Delete Apply Revert
-

0 Clique no botao Run.

0 Devera obter um erro na tab Console. Clicando no nome do ficheiro e

numero de linha no final do ficheiro o editor ira para esse local:

mEX]

File Edit Source Refactor Navigate Search Project Run Window Help

Ic-H@|#-0-%- | EBHE-|®2|[45 |8 -5 -6 0 = 2
e Herar... 32 1 = O[] Figurejava ‘ [3] Girde.java fmSmmﬁ b = 0[5z cutine 52 Tl
crde [, af $h B - T E"'/"‘ ) [»] Bww e
= @* Figure i . Start
LD crde 9 - @ % main(string[])
10public class Start {

e

# @param args

ol 4

public static void main(String[] args) {
new Circle(2, 2, 3.0);

rcle

Fiol| % 1AW W e

4 location

ar Figure(int, int)

@ "area()

@ equalLocation(Figure)
& F getlocation()

@ overlaps(Figure)
eh perimeter()

@ setlocation(int, int)
@ translate{int, int) Problems | Javadoc | Dedaration | &l console 22 ™ L % ‘ |;=’;| Eﬁ ‘ ] [Ez L‘ﬁ 5

<terminated> Start [Java Application] C:'Program Files\Java'jdk1.5.0_06'binYjavaw.exe (23/Abr/2006 19:25:10)

Exception in thread "main" jeva.lang.Assertion

System.out.println(c.area()):

22
23

L)

at pt.ipbeja.estig.p2.figures.Start.ma.

or E
n(Start.java:17)

[

| | Writable SmartInsert | 17:23
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Leitura complementar

O seguinte link talvez seja o melhor para uma primeira leitura sobre o que € o eclipse:

http:/ /wiki.eclipse.org/index.php/Eclipse_ FAQs

Existe imensa documentacao sobre o eclipse e os seus varios constituintes. O ponto de entrada principal é o seguinte:

http:/ /help.eclipse.org/help31 /index.ijsp

Tem comentarios a fazer a este texto? O que é que gostou mais? E menos? E do que é que nao gostou mesmo nada? Os seus eventuais
comentarios podem ser muito Uteis para ajudar a melhorar futuras edicoes deste texto. Por si e também pelos seus presentes e futuros colegas,

nao se acanhe! Diga coisas para jpb AT estig.ipbeja.pt.

Primeira versao: Beja, 18 de Abril de 2006. Ultima revisdo em 23 de Abril de 2006 as 19h:38m.
Autor: Jodao Paulo Barros

Pagina pessoal: http://www.estig.ipbeja.pt/~jpb
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